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Abstract

Background: Early postnatal exposure to general anesthetics may interfere with brain
development. We tested the hypothesis that isoflurane causes a lasting disruption in myelin
development via actions on the mammalian target of rapamycin (mTOR) pathway.

Methods: Mice were exposed to 1.5% isoflurane for 4 hours at postnatal day 7. The mTOR
inhibitor, rapamycin, or the pro-myelination drug, clemastine, were administered on days 21-35.
Mice underwent Y-maze and novel object position recognition tests (n=12 per group) on days
56-62 or were sacrificed for either immunohistochemistry (n=8 per group), Western blotting (n=8
per group) at day 35 or were sacrificed for electron microscopy at day 63.

Results: Isoflurane exposure increased the percentage of pS6+ oligodendrocytes in fimbria of
hippocampus from 22+7% to 51+6% (p<0.0001). In Y-maze testing, isoflurane-exposed mice did
not discriminate normally between old and novel arms, spending equal time in both (50+£5% old:
50+5% novel, p=0.999), indicating impaired spatial learning. Treatment with clemastine restored
discrimination, as evidenced by increased time spent in the novel arm (43+6% old:57+6% novel,
p<0.001) and rapamycin had a similar effect (44+8% old:56+8% novel; p<0.001). Electron
microscopy shows a reduction in myelin thickness as measured by an increase in g-ratio from
0.76+0.06 for controls to 0.79+0.06 for the isoflurane group (p<0.001). Isoflurane exposure
followed by rapamycin treatment resulted in a g-ratio (0.75+0.05) that did not differ significantly
from the control value (p=0.426). Immunohistochemistry and Western blotting show that
isoflurane acts on oligodendrocyte precursor cells to inhibit both proliferation and differentiation.
DNA methylation and expression of a DNA methyl transferase 1 is reduced in oligodendrocyte
precursor cells after isoflurane treatment. Effects of isoflurane on oligodendrocyte precursor cells
were abolished by treatment with rapamycin.
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Conclusions: Early postnatal exposure to isoflurane in mice causes lasting disruptions of
oligodendrocyte development in the hippocampus via actions on the mTOR pathway.

Summary Statement:
Early (postnatal day 7) isoflurane exposure in mice disrupts oligodendrocyte development and

myelin formation in hippocampal white matter via activation of mTOR and alterations of in DNA
methylation levels.

Introduction

Modern general anesthesia allows the safe performance of several hundred million surgical
procedures annually. 2 However, there is growing concern that some vulnerable categories of
patients, particularly young children, geriatric patients, and individuals with underlying
brain disorders, may be at risk of lasting cognitive dysfunction.24 While conclusive
evidence of anesthetic neurotoxicity has not been established in human studies, some animal
studies have shown that exposure to general anesthetics in early development cause impaired
neurocognitive performance®8 and that the peak period of behavioral and cognitive
vulnerability to general anesthetics in rodents occurs in early postnatal life.%-11 Based on
these studies, the U.S. Food and Drug Administration issued a warning that lengthy or
repeated exposure to general anesthetics and sedative drugs from the third trimester of
prenatal development through the first three years of life may cause lasting impairment in
the cognitive function.12 The molecular and cellular mechanisms underlying this
phenomenon remain poorly understood.

Most studies investigating anesthetic neurotoxicity have focused on neuronal development.
713 However, brain function is also dependent on the myelin-forming oligodendrocytes,
which undergo critical developmental events during the putative window of vulnerability.
Myelination involves proliferation of oligodendrocyte progenitor cells, differentiation of
oligodendrocyte progenitor cells into mature oligodendrocytes, and ensheathment of axons.
Myelin is critical for neurotransmission in the CNS and disruptions of myelin function are
associated with neurological and psychiatric disorders.1415 In this study, we test the
hypothesis that early postnatal exposure to isoflurane affects oligodendrocyte development
and myelin formation in the hippocampus in an /n vivo mouse model. To establish the extent
to which isoflurane-induced deficits can be attributed to impaired myelination, we employed
clemastine, an antimuscarinic drug approved drug for multiple sclerosis therapy, which
promotes oligodendrocyte differentiation and myelination and reverses the phenotype of
several murine disease models involving demylelination.16:17

Exposure to general anesthetics has been shown to impact molecular signaling pathways
implicated in the dynamic maintenance of cellular homeostasis and development.13
Recently, the mammalian target of rapamycin (mTOR) signaling has emerged as a critical
integrator of activity of nerve cells and synaptic inputs that in turn affect many cellular
metabolic processes.!® Studies have implicated mTOR signaling in neurodevelopmental and
neuropsychiatric disorders.1® We previously showed that isoflurane disrupts development of
newborn hippocampal neurons and synaptic formation via activation of the mTOR pathway.
7,20 1n this study, we further investigate the role of mTOR in isoflurane-induced
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neurotoxicity in mouse oligodendrocyte development and myelination using mTOR activity
markers and rapamycin, an mTOR pathway inhibitor. We explored the effects on axon-
oligodendrocyte precursor synapses, which are thought to be critical for turning
oligodendrocyte development to match neuronal activity.?1-23 Activity in the mTOR
pathway mediates DNA methylation in neurons 24 and cancer cells,2° and it has been
reported that DNA methylation is a well-recognized epigenetic modification that regulates
oligodendrocyte development and is necessary for efficient myelin formation.26-28 Thus, the
effect of general anesthetics and mTOR activation on DNA methylation level in
oligodendrocytes has also been investigated.

Materials and Methods

Animal paradigm and experimental timeline.

A total of 120 (61 male and 59 female) immature C57BL/6 mice (body weight = 4.4+0.9 g.
at postnatal day 7) were used in this study. 84 (44 male and 40 female) of them were
randomly selected for the rapamycin experiment and 36 (17 male and 19 female) for the
clemastine experiment. Sex was not factored into research design as a biological variable.
Both sexes were equally represented in all experiments. All study protocols involving mice
were approved by the Animal Care and Use Committee at the Johns Hopkins University and
conducted in accordance with the NIH guidelines for care and use of animals. Experimental
procedures followed the modified protocols from a previously published journal.’

At postnatal day 7, animals were exposed to isoflurane or room air for 4 hours. From
postnatal days 21-35, half of the isoflurane-exposed mice were injected (i.p.) bi-daily with
rapamycin (n=28 per group) or fed daily with clemastine through gastric gavage (n=12 per
group). The other half were injected with vehicle of rapamycin or fed with vehicle of
clemastine.

For the rapamycin experiment, a subset of mice from each group were sacrificed at postnatal
day 35 for immunohistochemistry (n=8 per group) or Western blotting (n=8 per group). The
remaining mice underwent behavioral testing for spatial learning and memory functions
between postnatal days 56-62 (n=12 for each group). After behavior tests, two mice from
each group were processed for electron microscopy at postnatal day 63. Only behavior tests
were conducted for clemastine feeding experiment (n=12 for each group) (Fig. 1A).

Isoflurane exposure.

At postnatal day 7, two-thirds of the mice were evenly distributed across littermate groups
and were randomly selected for isoflurane exposure. The other one-third of the mice stayed
in room air as a naive control. Volatile anesthesia exposure was accomplished using a Supera
tabletop portable non-rebreathing anesthesia machine. 3% isoflurane mixed in 100% oxygen
was initially delivered in a closed chamber for 3-5 min and after loss of righting reflex,
animals were transferred to the specially designed plastic tubes. A heating pad (36.5°C) was
placed underneath the exposure setup. The mice were exposed to 1.5% isoflurane carried in
100% oxygen for 4 hours. A calibrated flowmeter was used to deliver oxygen at a flow rate
of 5 L/min and an agent specific vaporizer was used to deliver isoflurane. During isoflurane
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exposure, mice were monitored for change in physiological state using the non-invasive
MouseOx plus instrument (STARR Life Sciences, Holliston, MA, USA). A collar clip
connected to the instrument was placed on the neck and a temperature probe placed on the
skin of the abdomen. Ten-minute readings with 1-hour intervals were taken. Data was
collected in four time-points and averaged for each case. The skin temperature (34.1+0.8°C),
pulse distention (168.9+36.6 um), heart rate (376.8+94.1 bpm), breath rate (77.4+35.8
brpm), and oxygen saturation (99.3+0.3%) were recorded. After the isoflurane exposure,
mice were returned to their moms together with their littermates upon regaining righting
reflex. All animals (100%) survived the isoflurane exposure.’

Rapamycin injection.

A total of 84 mice were equally divided into three groups: 1) naive control; 2) isoflurane
exposure plus vehicle; and 3) isoflurane plus rapamycin injection. From postnatal days
21-35, half of the isoflurane-exposed mice (group 3; n=28 per group) were injected
intraperitoneally with 0.2% rapamycin dissolved in vehicle solution and the other half with
vehicle only (group 2; n=28 per group). Vehicle consisted of 5% Tween 80 (Sigma Aldrich,
St. Louis, MO, USA), 10% polyethylene glycol 400 (Sigma-Aldrich, St. Louis, MO, USA),
and 8% ethanol in saline. Mice received 100 pl rapamycin or vehicle for each injection at 48
hour intervals from postnatal days 21-35. 7

Clemastine feeding.

In this experiment, 36 animals were also equally divided into three groups as above.
Clemastine (Tocris Bioscience, Bristol, UK) was dissolved in DMSO (Sigma-Aldrich, St.
Louis, MO, USA) at 10 mg/ml followed by further dilution in ddH20 into 1 mg/ml. From
postnatal days 21-35, half of the isoflurane exposed mice (n=12 for each group) were fed
clemastine (10 mg/kg) daily via gastric gavage using plastic feeding tubes (gauge 22;
Instech, Plymouth Meeting, PA, USA), and the other half (n=12 for each group) were fed
same volume of 10% DMSO as vehicle.16:17

Behavior tests.

The novel object position recognition test and Y-maze test were performed at the last week
of the survival period (postnatal days 56-62).” Experimenters were blinded to condition
when behavioral tests were carried out and quantified.

1). Novel object position recognition test: The test was assessed in a 27.5 cm x
27.5 cm x 25 cm opaque chamber. During the pre-test day (day 1), each mouse was
habituated to the chamber and allowed to explore 2 identical objects (glass bottles, 2.7 cm
diameter, 12 cm height, and colored paper inside) for 15 minutes. The mouse was then
returned to its home cage for a retention period of 24 hours. On the test day (day 2), the
mouse was reintroduced to the chamber and presented with one object that stayed in the
same position (old position) while the other object was moved to a new position (novel
position). A five-minute period of movement and interaction with the objects was recorded
with a video camera that was mounted above the chamber and exploratory behavior was
measured by a blinded observer. Exploratory behavior was defined as touching the object
with snouts. The numbers of exploratory contacts with the novel object and with the old
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object were respectively recorded, and the ratios over the total exploratory contact numbers
were calculated.

2). Y-maze test: In the pre-test phase (day 1), mice explored and habituated in the start
arm (no visual cue) and 1 out of 2 possible choice arms with overt visual cue (old arm) for
15 minutes. This was followed by the recognition phase (day 2) 24 hours later, in which the
animals could move freely in the three arms and choose between the 2 choice arms (old arm
and novel arm) after being released from the start arm. The timed trials (5 minutes) were
video recorded as well as graded by an observer blinded to the conditions for exploration
time in each choice arm and the percentages over total exploratory time were calculated.

Immunohistochemistry.

During postnatal days 30-35, 5-bromo-2’-deoxyuridine (Abcam, Cambridge, UK) was
injected intraperitoneally at 50mg/kg daily in animals randomly selected from three groups
(n=8 for each group). At postnatal day 35, mice were perfused with 40 ml 4%
paraformaldehyde in PBS. Brains were removed and post-fixed at 4°C overnight, followed
by 30% sucrose in PBS at 4°C for 48 hours. The brains were coronally sectioned in 40 pm
thickness using a freezing microtome. For each brain, 72 sections containing fimbria were
collected in a 24-well tissue culture plate and they were divided into twelve wells in a
rotating order (6 sections per well). Seven wells of sections were immunostained for: (1)
phospho-S6 and adenomatous polyposis coli; (2) 5-bromo-2’-deoxyuridine and neural/glial
antigen 2 ; (3) adenomatous polyposis coli and platelet-derived growth factor receptor alpha;
(4) vesicular glutamate transporter 1 and neural/glial antigen 2; (5) myelin basic protein; (6)
DNA methyltransferase 1 and Olig2 (oligodendrocyte transcription factor marker); (7) 5-
methylcytosine (5-mC) and adenomatous polyposis coli. For 5-bromo-2’-deoxyuridine
staining, sections were pretreated with 2N HCI to denature DNA (37°C; 45min), and with 2
x 15min borate buffer (pH 8.5) to neutralize the HCI. After 3x10min PBS washing, sections
were blocked in 10% normal goat serum and 0.1% triton X-100 for 60min, followed by
primary antibody incubation at 4°C overnight. Primary antibodies used in this study were:
rabbit anti-phospho-S6 (1:1,000; Cell Signaling, Boston, MA, USA), mouse anti-5-
bromo-2’-deoxyuridine (1:200; Abcam, Cambridge, UK), rabbit anti-neural/glial antigen 2
(1:200; Millipore, Burlington, MA, USA), mouse anti-adenomatous polyposis coli (1:2,000;
Millipore, Burlington, MA, USA), mouse anti-myelin basic protein (1:500; Santa Cruz
Biotechnology, Dallas, TX, USA), rabbit anti- platelet-derived growth factor receptor alpha
(1:500; Lifespan Bio, Seattle, WA, USA), mouse anti- vesicular glutamate transporter 1
(1;200; Abcam, Cambridge, UK), mouse anti-DNA methyltransferase 1 (1:100; Santa Cruz
Biotechnology, Dallas, TX, USA), rabbit anti-Olig2 (1:2,000; Abcam, Cambridge, UK), and
rabbit anti-5-methylcytosine (1:2,500; Abcam, Cambridge, UK). After 3x10min washes in
PBS, sections were incubated with secondary antibodies for 2 hours: Alexa 488 conjugated
goat anti-rabbit 1gG (1:300; Invitrogen, Eugene, OR, USA) mixed with Cy3 conjugated goat
anti-mouse 1gG (1:600; Jackson ImmunoResearch Labs, West Grove, PA, USA), or Alexa
488-goat anti-mouse 1gG (1:300; Invitrogen, Eugene, OR, USA) mixed with Cy3 conjugated
goat anti-rabbit 1gG (1:600; Jackson ImmunoResearch labs, West Grove, PA, USA). After
3x10min PBS washes, sections were mounted onto slides, air-dried, and cover-slipped.?!
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Cell counting and immuno-fluoresce intensity analysis in fimbria

The sections were observed and imaged using a Leica 4000 confocal microscope (Wetzlar,
Germany). All single- or double- immunolabeled cells within hippocampal fimbria area
were counted using ImageJ with cell counter plugin (NIH, Bethesda, MD, USA). The
criteria for counting mTOR active oligodendrocytes required a cell to have both phospho-
S6+ (in red channel) and adenomatous polyposis coli+ (in green channel) cytoplasm and
merged image of double labeled cells appeared yellow color (Fig. 1B). Proliferating
oligodendrocyte progenitor cells and 5-methylcytosine+ oligodendrocytes were counted for
cells that have 5-bromo-2’-deoxyuridine+ or 5-methylcytosine + nuclei and neural/glial
antigen 2+ or adenomatous polyposis coli+ cytoplasm. However, both DNA
methyltransferase 1 and Olig2 reactivity were seen in nuclei. Identification of excitatory
axon-oligodendrocyte progenitor cell synapses involved vesicular glutamate transporter 1+
terminal boutons closely apposing on the surface of neural/glial antigen 2+ oligodendrocyte
progenitor cells. For adenomatous polyposis coli and platelet-derived growth factor receptor
alpha double-stained sections, almost no double-labeled cells were seen, which means these
two markers label cells in different oligodendrocyte development stages without
overlapping.

Images containing fimbria were taken at 20x magnification in red (Cy3), green (Alexa 488),
and merged channels. All single- (Cy3+ or Alexa488+) and double-labeled cells in fimbria
were counted. Images were opened and initialized in ImageJ. The fimbria area was outlined
using the *‘Freehand’’ tool. “Plugins”, “Analysis”, and *‘Cell Counter’’ tools were selected,
and each labeled cell inside was clicked, with which each counted cell was marked
preventing the same cell from being counted twice. The numbers of counted cells were
automatically recorded. The ratio of a specific marker labeled oligodendrocytes (such as
yellow-colored phospho-S6+/ adenomatous polypaosis coli+ cells over all green adenomatous
polyposis coli+ cells in Fig. 1B) was calculated. For each case, numbers from 12 fimbria
images (6 sections, both sides) were averaged. There was almost no double staining for
adenomatous polyposis coli and platelet-derived growth factor receptor alpha. We the used
ratio of adenomatous polyposis coli+ over platelet-derived growth factor receptor alpha+
cells to evaluate the maturation of oligodendrocyte lineage cells. For axon- oligodendrocyte
progenitor cells synapse, five neural/glial antigen 2 positive cells from each image (60 cells
for each case) were randomly selected and photos were taken in a higher magnification
(40x). Every vesicular glutamate transporter 1+ terminal boutons apposing on each selected
cell were counted with imageJ and average numbers were calculated.

The fluorescence intensity of myelin basic protein immunoreactivity in fimbria were also
quantitatively analyzed using ImageJ. Photos of the fimbria area from immunostained
sections were taken at 20x magnification. ldentical photo exposure was set for all groups.
The image was opened with ImageJ and outline of fimbria was drawn with “Freehand” tool.
The “set measurements” was selected from the analyze menu and “integrated density” was
activated. A region in lateral ventricle was selected as background. The final myelin basic
protein intensity of fimbria area equals measured density minus background.
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Western blotting.

Eight animals from each group were quickly perfused with cold saline on day 35. From the
medial aspect of the hemisphere, the hippocampus was exposed and separated from brain
tissue. Fimbria located in the ventrolateral side of the hippocampus were easily identified by
bright white color under dissection microscope, and then removed with fine forceps. Fimbria
tissue was lysed in the lysis buffer, homogenized with a bullet bender (Next Advance, Troy,
NY, USA), and centrifuged. The supernatant was taken and stored in —80°C. The next day,
samples were prepared with 1:1 denaturing sample buffer (Bio-Rad, Hercules, CA, USA),
boiled for 5 min, and run on 4-12% Bis-Tris Protein Gels (Invitrogen, Carlsbad, CA, USA)
in running buffer (Invitrogen, Carlsbad, CA, USA) with 150 volts for about 1 hour. The
proteins were transferred to nitrocellulose blotting membranes (Invitrogen, Carlsbad, CA,
USA). Blots were probed with anti-neural/glial antigen 2 (1:200; Millipore, Burlington, MA,
USA), anti-NK2 homeobox 2 (1:200; Abcam, Cambridge, UK), anti-myelin basic protein
(1:500; Santa Cruz Biotechnology, Dallas, TX, USA), anti-DNA methyltransferase 1 (1:100;
Santa Cruz Biotechnology, Dallas, TX, USA) and anti-p-actin antibodies (1:1,000; Cell
Signaling Technology, Boston, MA, USA). The membranes with the primary antibodies
were stored in 4°C overnight. After incubation in secondary antibodies (1:2,000; Cell
Signaling Technology, Boston, MA, USA) for 1 hour, blots were visualized using ECL
western blotting substrate kit (Pierce Biotechnology, Waltham, MA, USA). Images were
acquired using ChemiDoc imaging system (Bio-Rad, Hercules, CA, USA) and were
quantitated with ImageJ (NIH, Bethesda, MD, USA). First, the images were opened using
File>Open. The rectangles around all lanes (each lane includes bands for detected marker
and pB-actin) were drawn by choosing “Rectangular Selection”. Then proceeding to
“Analyze>Gels>Plot Lanes”, peaks were generated representing the density of bands,
followed by clicking “Straight Line” tool to enclose the peaks and selecting the “Wand” tool
to highlight the peaks. After this, Analyze>Gels>Label Peaks was used to get numbers for
peak area (band intensity). The ratios of band density of oligodendrocyte lineage markers
over B-actin were calculated.?!

Electron microscopy.

Two animals from each group were perfused with 2% glutaraldehyde (Electron Microscopy
Sciences, Hatfield, PA, USA) plus 2% paraformaldehyde (Electron Microscopy Sciences,
Hatfield, PA, USA) in PBS at postnatal day 63 (after behavior tests) and post-fixed at 4°C
for 1 week. Brains containing fimbria were dissected into small blocks (2mm x 2mm x
2mm). The blocks were placed into 1% OsO4 (Electron Microscopy Sciences, Hatfield, PA,
USA) for 1 hour, stained in 0.5% uranyl acetate (Electron Microscopy Sciences, Hatfield,
PA, USA) overnight, and dehydrated in a series of alcohols followed by propylene oxide for
3 hours. After being infiltrated with a 1:1 mixture of propylene oxide and EMBed-812
embedding resin (Electron Microscopy Sciences, Hatfield, PA, USA) for 3 hours, the blocks
were embedded with the same resin in the plastic templates at 60°C overnight.2! Parasagittal
semi-thin sections (1 um) were cut and stained with 1% Toluidine blue for preliminary light
microscopy observation. Then, 90 nm ultrathin sections were cut, picked up on Forvar-
coated slotted grids, and stained with 0.5% uranyl acetate and 0.5% lead citrate (Electron
Microscopy Sciences, Hatfield, PA, USA). Thin sections were observed and imaged with a
Hitachi 7600 transmission electron microscope (Chiyoda, Tokyo, Japan). For each case, 10
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photos were randomly photographed at 20,000%. The thickness of myelin was quantitatively
measured by determining g-ratio, which was calculated by dividing the diameter of the axon
by the diameter of the entire myelinated fiber as previously described. ImageJ (NIH,
Bethesda, MD, USA) was used by first opening ultrastructural images. The scale was set
according to the scale bar in the images by selecting “Analyze>Set Scale”. The “straight line
tool” was selected to measure axonal caliber and diameter of myelinated axons. One
hundred axons per group (two animals, fifty from each) were randomly selected and
quantitatively analyzed (n=100).16

Statistical analysis.

Results

The statistics were performed with GraphPad Prism 6 (La Jolla, CA, USA) program. The
sample size was based on our previous experience with this design. No a priori statistical
power calculation was conducted. Normal distribution was verified using the D’ Agostino
Pearson test. Data for immunohistochemistry, Western blotting, and electron microscopy
were analyzed using one-way analysis of variance (ANOVA). The factor of variable was
comparisons among groups (control vs. isoflurane plus vehicle vs. isoflurane plus
rapamycin). The behavior tests were analyzed with two-way ANOVA. For this analysis, the
second factor was animal’s choice between old vs. novel positions (or arms) and only the
values for this variable in each individual group were compared. The Tukey post hoc test
was employed for intergroup comparisons. The two-tailed test was set according to
convention. The criteria for significant difference was set a prioriat p<0.05. In this study, all
results were expressed as mean * standard deviation (SD). The sample size “n” represents
the number of animals for each group. Only exception is g-ratio analysis with electron
microscopy in which “n” indicates the number of randomly selected axons from two mice
per group (n=100). This analysis way is extensively applied for g-ratio study.® Because all
animals survived tests, there were no missing data in this study. No exclusions for outliers
were made in this study. In some experiments, the sample size was increased in response to
peer review.

Effect of early isoflurane exposure on mTOR activity in oligodendrocytes in hippocampal

fimbria.

All experiments compared the three groups as follows: naive control, isoflurane exposure
plus vehicle, and isoflurane exposure plus treatment (rapamycin or clemastine). We first
assayed for activity in the mTOR pathway in oligodendrocytes by double labeling for
phospho-S6, a reliable reporter of activity in this pathway,?° and adenomatous polyposis
coli, a standard marker for oligodendrocyte. In the control group, 22+7% adenomatous
polyposis coli positive oligodendrocytes in fimbria were also immuno-labeled for phospho-
S6. There was a profound increase in the percentage of phospho-S6+/ adenomatous
polyposis coli+ cells over adenomatous polyposis coli+ cells to 51+6% in isoflurane
exposure mice (p<0.0001). However, this increase of phospho-S6+/ adenomatous polyposis
coli+ cells over adenomatous polyposis coli+ cells was prevented by treatment with
rapamycin (32+12%, £=0.001). These data indicate early exposure of a general anesthetic
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agent causing a lasting increase in the activity of the mTOR signaling pathway in the
oligodendrocytes of hippocampus white matter, and rapamycin attenuates this increase.

Effect of isoflurane exposure on spatial learning.

Next, we asked whether isoflurane exposure impairs spatial learning and memory behaviors
using the novel objective position recognition test (Fig. 2A) and Y-maze test (Fig. 2B), and
whether treatment with rapamycin or clemastine restores these functions in our exposure
paradigm.

1). Rapamycin study: In the novel object position recognition test, control animals
made 58+8% contacts with the object that had been repositioned as compared to 42+8%
contacts with the unchanged object (p<0.0001). The isoflurane-exposed mice made
essentially equal contacts at both objects (53+6% vs. 47+6% times; p=0.398). Rapamycin
treatment restored the performance to near control levels (55+8% vs. 45+8% times;
p=0.016) (Fig. 2C). In the Y-maze test, control animals exhibited a higher percentage of
exploration time in novel arm (58+5% exploration time) compared to the old one (42+5%
exploration time) (p<0.0001). Isoflurane-exposed animals without rapamycin treatment had
equal exploration times in both arms (50+£5% vs. 50+£5% time duration; p=0.999), and
rapamycin treatment restored performance in this task (56+8% vs. 44+8% time duration;
p<0.001) (Fig. 2D).

2). Clemastine study: In the novel object recognition test, control animals made more
contacts with the object in the novel position (57+8% vs. 43+8% times; p=0.007), but
isoflurane exposed animals exhibited no exploration preference (51+10% vs. 49+10% times;
p=0.998). Clemastine treatment increased the difference near the control cases (56£7% vs.
44+7% times; p=0.028) (Fig. 2E). Similarly, in the Y-maze test, unlike controls (58+6% vs.
42+6% time duration; p<0.0001), isoflurane exposed mice spent identical time in both old
and novel arms (51+£7% vs. 49+7% time duration; p=0.999), and this effect of isoflurane was
reversed by clemastine treatment (57+6% vs. 43+£6% time duration; p<0.001) (Fig. 2F).

Effects of isoflurane on oligodendrocyte development.

In order to measure the proliferation of oligodendrocyte progenitor cells, the brain tissue was
immunolabeled with antibodies against 5-bromo-2’-deoxyuridine and an oligodendrocyte
progenitor cells marker, neural/glial antigen 2. We examined proliferating oligodendrocyte
progenitor cells by counting 5-bromo-2’-deoxyuridine and neural/glial antigen 2 double-
labeled cells in fimbria. We counted 49+14% neural/glial antigen 2 positive oligodendrocyte
progenitor cells in control, and 27+9% neural/glial antigen 2 positive cells in isoflurane
exposed animals were 5-bromo-2’-deoxyuridine positive (p=0.001). This ratio number
increased to 47+7% (p=0.003) in isoflurane plus rapamycin injection group (Fig. 3A).
Interestingly, we found that neural/glial antigen 2 expression from Western blot in the
isoflurane exposure group (83+£20% intensity over p-actin) is slightly lower than the control
(87+15%, p=0.882) and rapamycin treatment groups (89+17%, p=0.819), but there is no
statistical difference among groups (Fig. 3B). However, expression level of NK2 homeobox
2, a transcription factor that identifies oligodendrocyte differentiation, was downregulated by
isoflurane (67£16% vs. 32+10% intensity over p-actin; p=0.001) and rapamycin attenuated
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this effect (58+£22% % intensity over B-actin; p=0.015) (Fig. 3B). We then performed
double-immunolabeling for adenomatous polyposis coli and the oligodendrocyte progenitor
cell marker platelet-derived growth factor receptor alpha, and applied oligodendrocyte/
oligodendrocyte progenitor cell ratio as a parameter to evaluate the oligodendrocyte
differentiation in fimbria. 30 The ratio of the number of adenomatous polyposis coli positive
mature oligodendrocytes over the number of platelet-derived growth factor receptor alpha
labeled oligodendrocyte progenitor cells in isoflurane exposed mice (233+43%) revealed
lower than in control (347+70% cells; p=0.002), and rapamycin treatment increases this
ratio (338+52% cells; p=0.003) (Fig. 3C).

To test the effects of isoflurane on axon-oligodendrocyte progenitor cell synapses, we
identified excitatory axon-oligodendrocyte progenitor cell synapses in the fimbria as puncta
that were immunopositive for vesicular glutamate transporter 1, which were closely apposed
on neural/glial antigen 2+ cell bodies. We found that the number of axon-oligodendrocyte
progenitor cell synapses on each oligodendrocyte progenitor cell in isoflurane exposure
(0.8+0.6 vGlutl+ terminals per OPC) showed a statistically significant reduction compared
to control (2.6£1.2 terminals per cell; p=0.001) and rapamycin treatment rescued these
synapses (2.2+0.7 per cell; p=0.008) from isoflurane exposure (Fig. 4).

Effects of isoflurane exposure on myelination.

To test for changes in myelination after anesthesia exposure, we measured fluoresce
intensity of immunolabeling for the myelin basic protein in fimbria. We found an immuno-
intensity reduction in isoflurane exposure (70+18% intensity over control) compared to
control conditions (100+17% control; p=0.006), which were partially restored with
rapamycin treatment (92+17% rapamycin treatment; p=0.041) (Fig. 5A). We then conducted
Western blot from fimbria tissue to confirm this finding. The band intensity of myelin basic
protein over B-actin showed a statistically significant decrease by isoflurane exposure
(110+30% vs. 60+£19% intensity ratio; p=0.002) and expression of myelin basic protein was
restored with rapamycin treatment (100+£26% intensity ratio; p=0.013) (Fig. 5B). For further
confirmation, we conducted electron microscopy to test for changes in the thickness of
myelin wraps after isoflurane exposure. The quantitative analysis revealed a statistically
significant increase of g-ratio (thinner myelin sheath) in isoflurane exposed animals than
control (0.76+0.06 vs. 0.79+0.06 g-ratio; p<0.001) and rapamycin treatment reversed this
difference (0.75+0.05 g-ratio; p<0.0001) (Fig. 5C).

Effects of isoflurane exposure on DNA methylation in oligodendrocytes.

We asked if early exposure to isoflurane has a lasting effect on DNA methylation levels in
oligodendrocytes. We observed that 60+15% of Olig2+ cells (a transcription factor marker
for oligodendrocyte lineage cells) in control conditions were double-labeled with DNA
methyltransferase 1 in fimbria as compared to only 42+12% Olig2+ cells (p=0.027) in the
isoflurane exposure group. Rapamycin treatment following isoflurane exposure increased
the ratio of DNA methyltransferase 1+/Olig2+ over Olig2+ cells (62+£11% ratio; p=0.01)
(Fig. 6A). Western blots were conducted which confirmed that DNA methyltransferase 1
expression is reduced with isoflurane treatment (25+8% intensity ratio over p-actin)
compared to control (58+21% intensity ratio over B-actin; p<0.001) and a partial recovery
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results from rapamycin treatment (49+9% ratio; p=0.006) (Fig. 6B). In order to determine
whether changes in DNA methyltransferase 1 levels have functional significance, we
assayed levels of 5-methylcytosine, which is a product of DNA methyltransferase 1
mediated DNA methylation, in oligodendrocytes. Isoflurane exposure decreased the ratio of
5-methylcytosine positive nuclei over adenomatous polyposis coli labeled oligodendrocytes
(33£13% ratio) relative to control (52+13% ratio; p=0.006), and rapamycin treatment
reversed this decrease (48+7% ratio; p=0.031) (Fig. 6C).

Discussion

In this study, we report that early postnatal exposure to isoflurane in mice causes a
substantial disruption of oligodendrocyte development and myelination in fimbria of the
hippocampus, which is the predominant bundle of efferent axonal fibers from the
hippocampus. Proliferation and differentiation of oligodendrocyte progenitor cells are
chronically impaired by early isoflurane exposure, as is the formation of synaptic
connections between oligodendrocyte progenitor cells and axons. This results in a
measurable loss of myelin in the fimbria. Proper connections and communications between
hippocampus and the neocortex are critical for performing the cognitive and psychological
functions.14 31. 32 Myelination is essential in establishing connectivity in the growing brain
by facilitating rapid and synchronized information transfer across the nervous system. Once
thought of as solely a passive insulator, myelin is now understood to be actively involved in
the function and development of the CNS.33 Abnormal myelination of axons disrupts the
communications between brain regions, and it has been reported that myelin deficits in the
hippocampus cause cognitive and psychological disorders.34-36 Previous studies have shown
an acute increase in apoptosis of oligodendrocytes, the myelin forming glial cells, with early
exposure to isoflurane,3”- 38 but our findings demonstrate a lasting effect of anesthesia on
oligodendrocyte proliferation and differentiation that results in a decrease in myelination in
the hippocampal fimbria.

The process of oligodendrocyte development occurs based on an intrinsic program that is
modulated by neurotransmitters and electrical activity in CNS.39-41 Axonal terminals release
glutamate as a transmitter at not only axonal terminals but also at discrete sites along axons
in white matter.2 By acting on AMPA or NMDA receptors expressed on oligodendrocyte
progenitor cells, glutamate increases the downstream phosphorylation of the cAMP response
element binding protein and release of calcium from intracellular stores,*3 thereby
promoting oligodendrocyte progenitor cell proliferation and differentiation. As an agonist of
GABA-A and glycine receptors,* as well as a potential NMDA inhibitor,*® isoflurane
suppresses excitatory neurotransmission. It raises the possibility that a profound direct
action on oligodendrocyte progenitor cells, which express both GABA and NMDA
receptors, is caused by isoflurane during a critical period in development and that this may
alter the developmental program, thus resulting in deficits in myelination. An alternative or
complementary explanation may be an indirect effect mediated by the electrochemical
synapses that occur between axonal terminals and oligodendrocyte progenitor cells (axon-
oligodendrocyte progenitor cell synapses). Formation of glutamatergic axon-
oligodendrocyte progenitor cell synapses plays an important role in promoting activity-
dependent oligodendrocyte development and maintenance.2-23 The chronic, lasting effects
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of isoflurane on neuronal synapses that we have previously shown may translate into
reduced activity at axon- oligodendrocyte progenitor cell synapses, thus leading to
suppression of oligodendrocyte progenitor cell development. A previous study showed that
plasticity of axon-oligodendrocyte progenitor cell synapses is highly dependent on electrical
activity.2 The data in this study further confirms that exposure of isoflurane reduces the
number of excitatory (vesicular glutamate transporter 1 positive) axon-oligodendrocyte
progenitor cell synapses in hippocampus, which is likely a key mechanism of general
anesthetic-induced hypomyelination.

Our previous work has indicated that exposure to isoflurane disrupts the development of
hippocampal neurons generated in the early postnatal period by inappropriately increasing
activity in the mTOR pathway and we found that both behavioral and histological changes
could be reversed by pharmacologic mTOR inhibition.” In the present study, as in neurons,
we observe a lasting alteration in the tone of mTOR signaling in oligodendrocytes in the
hippocampal fimbria for a protracted period after isoflurane exposure which appears to be
integral to the developmental disruption. We found a substantial improvement in phenotype
with rapamycin treatment in this study as well. The mTOR pathway is an intracellular
signaling pathway that regulates cellular activities including proliferation, differentiation,
apoptosis, metabolism, transmitter release, and other biological processes.8 In the past
decade, many studies have implicated mTOR signaling in CNS developmental and
neuropsychiatric disorders.1® Two structurally and functionally distinct mMTOR-containing
complexes have been identified in oligodendrocytes. The first, MTOR complex 1
(mTORCY1), contains the adaptor protein Raptor, which influences myelin basic protein
expression via an alternative mechanism and is sensitive to the drug rapamycin. The second
complex, mTORC2, contains Ritor, and it is thought to control myelin gene expression at
mRNA level and is relatively rapamycin insensitive.4’

The mTOR pathway itself plays a complex role in myelination; mTOR activity can either
enhance or suppress oligodendrocyte development depending on the context. A study using
a mouse line with oligodendrocyte-specific knockdown of mTOR in CNS has provided
evidence that mTOR is essential for oligodendrocyte development and myelination.*8
Inhibition of mTOR via rapamycin in cultured adult oligodendrocyte progenitor cells or in a
mouse model starting at 6 weeks of age results in oligodendrocyte differentiation deficits
along with reduced expression of major myelin proteins and mRNAs.49-51 In contrast,
activation of mTOR induced by tuberous sclerosis complex —1 or 2 gene mutations in early
oligodendrocyte progenitor cells caused white matter abnormalities, including myelin
deficits in CNS.52-54 A bidirectional action of the PI3K-Akt-mTOR axis in myelination has
also been reported in studies of the PNS. If tuberous sclerosis complex —1 deletion occurs in
early developmental stages in Schwann cells, mMTOR hyperactivity arrests the process by
which Schwann cells ensheathe axons. If mTOR activity is increased in Schwann cells after
they have begun wrapping around axons, there is actually in increase in myelination.>® Thus,
oligodendrocyte development and myelination may be dependent on precise balance and
timing in mTOR signaling. Either increasing or decreasing levels of mMTORC1 activity
interferes with oligodendrocyte differentiation and causes potentially causes
hypomyelination.>8
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While we do not yet have a clear picture of how changes in mTOR activity act on
oligodendrocytes, our data indicate changes in DNA methylation as a promising direction.
Recent work shows developmental anesthetic toxicity may involve epigenetic modulation 57
and that DNA methylation plays an important role in regulating oligodendrocyte progenitor
cell proliferation and differentiation.26-28 Intriguingly, mTOR signaling has been shown to
negatively regulate DNA methylation via an action on DNA methyltransferase 1,24 25
suggesting a possible connection between mTOR signaling and oligodendrocyte
development. This finding is consistent with our data showing that isoflurane exposure and
concomitant increases in mTOR signaling lead to a decrease in DNA methyltransferase 1
expression and DNA methylation in developing oligodendrocytes, and that both of these
changes are reversible with rapamycin treatment.

We propose that oligodendrocytes should be further studied both as a potential target in
anesthetic neurotoxicity and as a model system in which to further explore the interplay of
anesthetics, mTOR signaling, and DNA methylation. Our work is limited by the rodent
model, which has well-known confounds related to anesthetic administration in very young,
small mice in which physiologic monitoring and control of respiratory function is
challenging. In particular, we have chosen to use 100% oxygen as a carrier for isoflurane,
which has the beneficial effect of preventing hypoxia in our model system, but which raises
the possibility of a combined effect of isoflurane and hyperoxia damage that cannot be fully
controlled for in our experimental model. While it is indeed the case that supplemental
oxygen is frequently used in pediatric anesthesia practice it would be ideal to avoid
confounds presented by hyperoxia and other physiologic issues via studies in large animal
models and in cell culture models and we hope further work in this area will be undertaken
in these systems.
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Fig. 1.
(A) Experimental timeline. A total of 120 mice (84 for rapamycin injection and 36 for

clemastine feeding experiments) were used in this study. At postnatal day 7, two-thirds of
the mice were exposed to isoflurane carried for 4 hours and the other one-third of the
animals remained in room air as naive control. From postnatal days 21-35, isoflurane-
exposed mice were injected (i.p.) with rapamycin or vehicle at 48 hour intervals; or daily fed
with clemastine or vehicle. Mice were sacrificed at postnatal day 35 for
immunohistochemistry and Western blotting, or at postnatal day 63 for electron microscopy.
The novel objective position recognition test and Y-maze test were performed during
postnatal days 57-62. (B). Effect of early isoflurane exposure on mTOR pathway activity in
oligodendrocytes of hippocampus fimbria. Coronal brain sections from control, isoflurane
exposure, and isoflurane plus rapamycin groups were immunostained with adenomatous
polyposis coli (APC; green) and phosphor-S6 (pS6; red) antibodies. Arrows indicate
phospho-S6+ and adenomatous polyposis coli+ double-labeled cells (yellow) in merged
images. Scale bar=10 um. The histogram shows quantitative results. In isoflurane-exposed
mice, the ratio of phospho-S6+/ adenomatous polyposis coli+ over adenomatous polyposis
coli+ cells is dramatically increased compared to control and this increase is reversed with
rapamycin treatment. (n=8 for each group; One-way ANOVA; **: p<0.01; ****: p<0.0001).
Iso: isoflurane. Error bars represent SD.
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Fig. 2.

Isc?flurane impairs cognitive functions via mTOR activity. (A). Novel object recognition test.
On day 1, mice were allowed to explore two identical objects in an opaque chamber. On day
2, one object was moved to a novel position. Exploratory behavior was defined as the
number of object-contacting with snouts. (B). Y-maze test. On day 1, mice habituated in the
start arm and one choice arm. On day 2, the animal could choose between two arms.
Exploration time in both arms was respectively recorded. (C). Novel object recognition test
for rapamycin study. Control animals made more contact with the object in the novel
position than that in the old position. Isoflurane-exposed mice have identical contacts for
both positions. Rapamycin treatment restores performance to near control levels. (D). Y-
maze study. Control animals stayed in the novel arm for longer time than in the old arm.
Isoflurane-exposed animals stayed in both arms for same time. Rapamycin treatment
reversed this ratio to near control. (E). Novel object recognition test for clemastine study.
Control animals spent more time exploring the object in the novel position, but isoflurane-
exposed animals exhibited no exploration preference. Clemastine treatment increased
difference near the level of control animals. (F). Y-maze test. Similarly, isoflurane mice
spent identical time for both arms, but this effect of isoflurane was reversed by feeding
clemastine. The statistics was Two-way ANOVA (n=12 for each group; *: p<0.05; **;
p<0.01; ***: p<0.001; ****: p<0.0001; ns: no significance). Error bars: SD.
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Fig. 3.
The effect of isoflurane exposure and rapamycin treatment on oligodendrocyte development

in fimbria. (A). Oligodendrocyte progenitor cell proliferation was detected with 5-bromo-2’-
deoxyuridine and neural/glial antigen 2 double-immunolabeling. A reduction in 5-bromo-2’-
deoxyuridine +/ neural/glial antigen 2+ cells in isoflurane-exposed animals was observed
compared to the control. This number was increased in isoflurane plus rapamycin injection
group. Scale bar=20um. (B). Western blot data indicated that the neural/glial antigen 2 level
was not altered by isoflurane exposure and rapamycin administration. Expression of NK2
homeobox 2, a transcript factor for oligodendrocyte differentiation, was downregulated by
isoflurane and rapamycin treatment attenuated this effect. (C). Oligodendrocyte
differentiation was analyzed with lineage tracing using immunohistochemistry. The ratio of
adenomatous polyposis coli+ mature oligodendrocyte number over platelet-derived growth
factor receptor alpha+ oligodendrocyte progenitor cells in isoflurane-exposed mice revealed
reduction compared to control, and rapamycin treatment increases the ratio. Scale
bar=20um. (n=8 for each group; One-way ANOVA; *: p<0.05; **: p<0.01; ns: no
significance). Iso: isoflurane. Error bars indicate SD.
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Fig. 4.
The effect of isoflurane exposure and rapamycin treatment on the numbers of excitatory

axon-oligodendrocyte progenitor cell synapses in fimbria. The vesicular glutamate
transporter 1+ axon-oligodendrocyte progenitor cell synapses were identified with terminals
apposing on neural/glial antigen 2+ oligodendrocyte progenitor cells (arrows indicate these
synapses). The number in isoflurane exposure mice was lower than control and rapamycin
treatment rescued these axon- oligodendrocyte progenitor cell synapses. Scale bar=5um.
(A). Control. (B). Isoflurane exposure plus vehicle group (C). Isoflurane exposure with
rapamycin treatment. (D). Graph showing quantitative data (n=8 for each group; One-way
ANOVA,; **: p<0.01). Iso: isoflurane. Error bars equal SD.
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The effect of isoflurane exposure and rapamycin treatment on myelination in fimbria. (A).
Myelination was quantitatively analyzed with myelin basic protein immunostaining. The
myelin basic protein intensity in isoflurane-exposed mice was reduced compared to control
conditions and is increased with rapamycin treatment. For this analysis, the same exact
photo setting was performed for all groups. * in photos: CA3 of hippocampus; fi: fimbria of

hippocampus; LV: lateral ventricle. Scale bar=200um. (B). Western blot data indicated

expression of myelin basic protein was decreased by isoflurane exposure and then elevated

by rapamycin treatment. (C). Electron microscopy analysis was performed in fimbria

parasagittal ultrathin sections. The ratio of axonal caliber over diameter of myelinated fiber
(g-ratio) was increased in isoflurane-exposed animals (it means decreased myelin thickness)
compared to control, and rapamycin treatment reversed this change. Scale bar=0.5um. n=8
for each group in (A), (B), and n=100 for each group in (C). One-way ANOVA; *: p<0.05;

**: p<0.01. Iso: isoflurane. Error bars indicate SD.
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Fig. 6.
The effect of isoflurane exposure and rapamycin treatment on DNA methylation level in

oligodendrocytes. (A). DNA methylation level examined with DNA methyltransferase 1 and
Olig2 double immunolabeling. The percentage of DNA methyltransferase 1+/Olig2+ over
Olig2+ nuclei in isoflurane-exposed mice was lower than control and rapamycin increased
this ratio. Scale bar=25 um. (B). Western blot data revealed isoflurane dramatically
decreased the DNA methyltransferase 1 level and rapamycin increased DNA
methyltransferase 1. (C). 5-methylcytosine, the product of DNA methylation catalyzed by
DNA methyltransferase 1, was detected in nuclei of adenomatous polyposis coli+
oligodendrocytes. The ratio of 5-methylcytosine +/ adenomatous polyposis coli + over
adenomatous polyposis coli+ cells showed a statistically significant decrease with isoflurane
exposure and rapamycin injection reversed this decrease. Scale bar=25um. (n=8 for each
group; One-way ANOVA; *: p<0.05; **: p<0.01; ***: p<0.001). Iso: isoflurane. Error bars
represent SD.
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